
Introduction to Adobe Photoshop CS6            
 
Open Image 

Opening an Existing Image or File             

Once you have opened Photoshop, you can start editing right away! Follow the directions below to open an 

existing Photoshop file (.psd) or image (.jpg). 

 

To open a Photoshop document or image: Go to File and select Open... 

 

A Browse window will appear and you can locate your file, select it, and click Open. 

Tip: To re-open a recently opened file, select Open Recent to select from a list of recently opened files. 

Create Image 

Create a New Photoshop File                   

Although you may typically open images in Photoshop, there are times when you need to create a new file. 

This may happen when you want to make a collage, create a web banner, design an ad, or more. This page will 

show and explain each section of the new dialog box. 

1. To create a new document: Go to File and select New... 

 

2. Use the guide below to set your desired document size and settings. 

 

New Document Dialog Box 

1. Name 

The Name field is where you can add a name to your 

new document. This should be a name that helps you 

easily identify the file. 

 

 

 

 

 



2. Preset 

The Preset field is where you can choose whether you would like to base your document size on a provided 

preset or by creating your own custom size. 

3. Size 

If you chose Custom as your Preset, then you will not have to use this dropdown.  

 

If you chose to use any other Preset above, then you will see size options based on the Preset you 

selected. For example, if you selected U.S. Paper, you will then see common U.S. paper sizes such as 

Letter, Legal, and Tabloid.  

 

If you are unsure of a good size for your document, we recommend trying one of the Presets and pre-

determined sizes. 

4. Width & Height 

 

If you did not select a Preset and chose to create a custom size, then this is where you can type in your 

desired document width and height. Note that you may change the units, by clicking 

the dropdowns beside the width and height values and selecting inches, pixels, 

centimeters, etc. 

INCHES- When using inches you can determine how big you want to be able to 

print your image and the higher the DPI/PPI you have (200 or higher for print/ 72 

for Web only) the better the quality.  You can convert this all into Pixels and do it 

that way as well.  

 

5. Resolution 

The resolution is what determines the quality of the image and refers to the number of pixels 
per inch (PPI) of the image.  
 

Image resolution is typically described in PPI, which refers to how many pixels are displayed 
per inch of an image.  

Higher resolutions mean that there more pixels per inch (PPI), resulting in more pixel information and 
creating a high-quality, crisp image.  

Images with lower resolutions have fewer pixels, and if those few pixels are too large (usually when an image is 
stretched), they can become visible. [shown below] 

 



When you change the resolution of an image, you are saying how many pixels you want to live in each 
inch of the image. For example, an image that has a resolution of 600 ppi will contain 600 pixels within each 
inch of the image. 600 is a lot of pixels to live in just one inch, which is why 600ppi images will look very crisp 
and detailed. Now, compare that to an image with 72ppi, which has a lot fewer pixels per inch. As you've 
probably guessed, it won't look nearly as sharp as the 600ppi image. 
 
Resolution rule of thumb: When scanning or photographing, always try and capture the image at the largest 
resolution/quality. Which means you will have a larger File. 

It's better to have more information than not enough! It's much easier for image editing applications, like 
Photoshop, to discard any unwanted image information (reducing the size of an image) than it is to create new 
pixel information (enlarge an image).  

Choosing the Correct Resolution for your Image 

Printing 

Some professional, high-end printers may require images to be up to 600 ppi for printing. Always check with 
your printer/publisher about required image resolution before submitting images. 

Non-Professional 

Non-professional printers such as inkjet, laser, and other common printers can best print images that are at 

least 200 to 300 ppi and higher. For images that just need to "look good", 200 ppi will work. Photographic 

prints are recommended to be at least 300 ppi. Images for large format poster printing can be around 150-

300ppi depending on how close the image will be viewed.* 

 

Web 

The idea has been for many years that images should be saved with a resolution of 72 ppi. Even images that 

are saved in Adobe Photoshop using the File > Save for Web and Devices command, are saved at 

resolutions of 72 ppi But the common misconception is that this resolution or ppi value is the deciding factor 

of image quality for web images, where it is actually about pixel dimensions (http://medialoot.com/blog/high-

resolution-web/).  

7. Color Mode 

Color mode allows you to choose what mode and bit you wish to use for your new 

document. Note: CMYK refers to print colors and is generally used for images that will be 

printed. RGB refers to the dot colors and is intended for use of web, video, or any digitally 

displayed image. 

 

8. Background Contents 

This allows you to determine the color of your Background layer. Choosing White or Transparent will make 

your layer respectively white or transparent. Choosing Background Color will change the layer color to 

whatever is currently selected as the Background Color in the Color Palette. 

10. Pixel Aspect Ratio  

 The pixel aspect ratio is useful for those who are creating graphics to be 

used for video work that is not HD or does not use square pixels.  

 

11. Image Size  This refers to the file size of your new document, 

meaning how much space on a hard drive or disk is needed to save the 

file. This number is measures in bytes, kilobytes (K) , megabytes (M), and 

gigabytes (G). 

http://medialoot.com/blog/high-resolution-web/
http://medialoot.com/blog/high-resolution-web/


 
Saving a Photoshop file 

 

(PSD) It is highly recommended to save a copy of your Photoshop file as a Photoshop Document or .PSD. A 

Photoshop file or PSD and the benefit of saving a PSD is that it will store all of your layers, even hidden ones, 

so that you may come back and edit them later. This allows for more freedom in editing your images at a 

future time. Think of the PSD file as something for your archival purposes. 

 

Save a File for Sharing (JPEG)  

We all know that not everyone has access to Photoshop, so this means that not everyone can open your PSD 

files. Additionally, you cannot upload a PSD file to most photo-hosting websites like FlickR or Imgur. PSD files 

are perfect if you want editing an image again in the future, but not good for sharing. This is where image files, 

such as .JPEG, .GIF, and .TIFF, come into the picture. These files differ from PSD files in the fact that they are 

"flat" and often do not contain layer information that can be edited at a later time.  

 

 

Saving Images (for printing or turning in) 

Here are the steps you'd take to save your file for print purposes:  

Once you are finished editing your work, save it as a .psd and then go to LAYER- FLATTEN IMAGE 

1. In order to save your image for print purpose, choose "File" in the top menu of your Photoshop 

window, then "Save As". 

 You should then see a dialog box appear with several different options for saving 

your file. Type on the Name of the image in the SAVE AS line and then change the 

format. 

 

 

  

 From here, choose your file type by 

selecting one in the "Format" box.  

  

 

 You're almost there! Finally, 

click "Save" to complete this process. Before finally exporting 

your image, Photoshop will prompt you to fine tune some 

options that are specific to the file type you chose.  

 

Example: 

This is usually just a set of options that let you fine tune exactly how 

you want your final image processed. Unless you need to tweak 

something very specific about the way your image is being saved, you 

can usually always hit "Ok" to accept Photoshop's default exporting 

features.  

 

 



Saving Images (for web) 

Save As For Web: 

Perhaps you’ve been working on an incredibly high quality image that was originally meant for print purposes, 

and now you’d like to share it on the web. Or, maybe, you’ve cut down a video file to 25-50 frames and made 

an animated .gif file that you’d like to share online. In either of these instances, using the “Save As for Web” 

offers great options that are specific to online environments. 

With static images (as in a JPEG file), you may want to compress differently so that your file size doesn’t end 

up being too large; this would be especially important for uploading images to websites that have file size 

limitations, or for webpage loading purposes. 

To begin, choose “File —> Save for Web” 

You should then see a dialog box appear: 

Depending on which file type is selected, you may 

see different options in this dialog box. I’ve got mine 

set to JPEG, and there's a plethora of information 

available to me: file type (JPEG), "Quality" (which is 

indicated by the slider), "Preview" options (which 

currently has "Monitor Color" selected), "Convert to 

sRGB" colorspace option, width and height options, 

and the file size (in the bottom corner of each 

image). You can even have a “2-Up” screen where 

you can compare both the original image and its 

compressed version off to the right: 

 

Two particular things you may want to specifically 

change are the dimensions of the image (width and height) and 

the “quality” settings. These will have a noticeable effect on the 

size of your image:                                                                               

All of the changes you make are best assessed visually, so feel 

free to play around with these sliders and tuners until you’ve got 

an image you’re satisfied with. And remember, you can always 

look at the bottom corner of the screen to assess how large your 

file is before exporting. 

When you’re happy with your changes, you can select “Save”. The best part is that this process is 

independent from the original image you’re working with. So any changes that you make in this screen don’t 

affect the file sitting in your Photoshop file, which is incredibly helpful! Your layers/changes/edits are 

preserved and unaffected for any other processing you’d like to do later. 

 

 

 

 

 

 

 



Palettes 

 

Introduction to Palettes 

Palettes [shown right] are groups of tools used to edit and 

manipulate your image. 

Photoshop contains over two dozen palettes that can be shown or hidden by 

using the Window menu and selecting the palette you wish to reveal. 

Palettes with a checkmark beside their names [below] indicate that they are 

open in your Photoshop workspace and selecting those check marked 

palettes will hide them.  

 

Can't find your palette? No worries! 

Palettes can be organized in many different ways in 

the Photoshop workspace. One way is by grouping 

several palettes together in a window and create tabs. 

 If you look at the image [shown right], notice that 

behind the Layers Palette there are tabs for 

the Channels and Paths palettes which are 

grouped behind the Layers Palette. 

 

Additionally, palettes can be collapsed or minimized in your Photoshop 

workspace and can be hard to locate.  Collapsed palettes will appear as 

icons [shown left] and can be expanded by clicking on the icon of the 

palette.  

 

 

 

 

Make it personal! 

To make your Photoshop experience more enjoyable, take advantage of 

customizing your workspace! 

Photoshop comes with several presets of workspaces, each having unique palettes and options revealed. You 

can change your workspace by going to Window in the menu, selecting Workspace, and selecting one of 

the presets. Know that palettes can also be hidden, revealed, moved, and organized however you would 

like! You can move (by clicking on the palette's tab and dragging it) and customize the palettes in your 

Photoshop workspace and save them to use later by going to Window in the menu, select Workspace and 

then New Workspace or once your workspace has been customized to your liking save the workspace: Go to 

WINDOW- SAVE WORKSPACE. 

 

 

 

 

 



Tools and Options Palettes 

 

The Tools Palette 

As you may have guessed, is the palette that houses all of Photoshop's wonderful tools. 

Use the following directions to learn how to select tools from the Tools Palette. 

1. Click on the tool icon to select that tool. 

  

 

 

2. Hover your cursor over the tool icon to reveal its name and (keyboard shortcut). 

 

 

 

3. Click and hold down on any tool icon that has a white triangle in the bottom right to reveal 

related tools nested underneath. 

 

 

The Options Palette 

 

Think of the Options Palette as the sidekick to the Tools Palette. Whenever you select a tool from the Tools 

Palette, the Options Palette will display all of the options for that selected tool. For example, if you select 

the Type Tool, the Options Palette will display options related to text such as font, type size, color, and 

more [below]. 

 

The Options Palette is located at the very top of your Photoshop window just below your Menu. It's 

conveniently located so that you can quickly and easily adjust your tool's properties as you use them. 

 

Note: If you ever find your Tools or Options palettes missing, go to Window in your Menu and select 

either Tools or Options from the list to reveal the palettes. 

 

 

 

 

 



Layers and Adjustments Palettes 

The Layers and Adjustments Palettes 

The Layers Palette [below; left] is the home of all of your layer information where it can be stored and 

organized. It lists all layers in an image, and a thumbnail of layer contents appears to the left of the layer 

name. You use the Layers Palette to create, hide, display, copy, merge, and delete layers. Learn more. 

 

The Adjustments Palette [below; right] is where you would select adjustments that you wish to apply to 

layers. This palette includes many different adjustments including exposure, color balance, saturation, and 

brightness / contrast. Learn more. 

 
Layers Palette 

 
Adjustments Palette 

  

Color Palette 

The Color Palette 

  

The Color Palette is where you can select and change your foreground and background colors that will 

be used with brushes and fills. Look at the screenshot of the Color Palette below and take note of the two 

stacked boxes, shown as black and white. In the screenshot, note that the foreground color is the top box 

(black) and the background color is the bottom box (white). 

Note: Click on the list icon ( ) in the Color Palette to change 

the color space from RGB to CMYK, Grayscale, Lab, and more. 

http://guides.lib.umich.edu/aecontent.php?pid=404188&sid=3815811
http://guides.lib.umich.edu/aecontent.php?pid=404188&sid=3308882


To change the color, select either the 
foreground and background color box in the 
Color Palette by clicking on it. Then, use 
either the sliders or click in the spectrum 
below the sliders to select a new color. If you 
do not like using the sliders, double click on 
a color box to bring up the Color 
Picker [shown right]. 
 
 
 
 
 
 
 
 

Selecting a Color from the Color Picker  

Also know that you can select and change Foreground and Background colors within your 

Tools Palette by using this mini color palette located near the bottom of the Tools Palette. 

 

 

History Palette 

The History Palette – Saving a Snapshot 

The History Palette is a log of all the actions you perform within Photoshop. By default, the History 

Palette contains the last 20 changes to your image. Each time you change the image, a new state is added to 

the History Palette. To jump to a particular state, click on that state name in the History Palette and all other 

actions after that state will become greyed out and italicized. 

 

[Left image: Shows the current state and recent actions performed | Right image: Shows going back to a 

previous state] 

 

Note: If you go back to a previous state and then perform a new action, you will record over 

all previous actions and edits. 

 

The Snapshot command lets you take a snapshot of any state in the History Palette of your image. The new 

snapshot is added to a list of snapshots located at the top of History Palette.  To create a snapshot: 

1.     Select the state that you want to capture. 

2.     Click the New Snapshot icon ( ) at the bottom of History Palette 



Layers 

What are Layers?  

Layers are one of Photoshop’s most powerful features as they are individual slices of information that 

can be stacked or moved to create your image composition. With layers, you can draw, edit, paste, and 

reposition elements on one layer without disturbing the others.  

 

This graphic shows how layers would be stacked to create a composite. Layers contain both transparent and 

opaque elements, so keep this in mind when stacking. Looking at the example, notice that the top layer that 

contains text saying, "Photoshop 'till you drop!” Only the text in that layer is opaque and the rest of the layer is 

transparent so that information below it - the person,  

cursor, and background color - are still seen. In Photoshop, transparency is identified by a white and gray 

checkered pattern. 

Read the sections below to learn more about how to move, organize, and change settings using layers. 

Organization 

Navigating and Organizing Layers 

The organization of layers and the ability to easily navigate are very important factors when working 

with layers. This section will show you how to select, move, create folders, search, and organize layers. 

Selecting a Layer 

In order to perform most actions in Photoshop, you will need to have at 

least one layer selected. You may use the MOVE TOOL or 

1. To select a layer, just click on it in the Layers Palette. The layer will 

turn blue [shown right] to indicate that it has been selected. 

2. To select several layers, hold down the CTRL key on your keyboard 

and click on each layer you would like to have selected. To select 

several consecutive layers, select the first layer and then hold the 

SHIFT key and select the last layer. 

 

Moving Layers 

As you know, the order in which layers are stacked does make a difference to the appearance of your 

image. It is important that you know how to move layers so that you are able to change the order of them as 

needed.  

1. Select the layer(s) you wish to move.  Click and hold your mouse and drag the layer to the desired 

position. A thick line will appear between layers to indicate where the layer will be dropped. Once you 

have the layer where you want it, release your mouse and the layer will move to the new location. 

 

  

 

 
Example of a selected layer. 



Creating Groups 

Another feature to help keep you and your layers organized is to create folders, also known as groups. You can 

add layers to a group and organize them however you wish.  

 

Create a new folder by clicking the "Create a new group" button (  ) at the bottom of the layers 
palette. 
 

Drag layers onto the group folder layer to add them to the group. 
 
Double-click on the Group Name in the Layers Palette to rename it. 

  
1. Click "Create new group" icon 

 
2. Drag layers into the group 

 Types 

Types of Layers 

There are many types of layers! Some layers are pieces of a final image that you are putting together, 

some are shape or text layers (created automatically), and some are fill or adjustment layers. Fill or 

adjustment layers allow you to play with different colors or effects without changing your main image. If you 

change your mind, you can delete or alter the fill or adjustment layer, and your original image layer is still 

intact. 

 

Background Layer  

Whenever you first open an image in Photoshop, the default layer 
containing that image will be called the Background Layer. The Background 
Layer is a protected layer, and many filters and effects cannot be applied to 
background layers.  
 

Background layers will always be named, "Background", and will be 
locked, or protected, by default.  To unprotect the background, double-click 
layer's name in the Layers Palette, a dialog box will appear where you can 
change the layer name and other details if you'd like, click OK and your layer 
will now be unprotected. 

 

  



Image Layer 

Image Layers are layers that contain any image 
information. Whenever we create a new layer, by default it is 
an Image Layer. The Layer Thumbnail of Image Layers contains a 
preview of the contents of that layer.  

 

Adjustment Layer 

Adjustment Layers are layers that contain only image 
adjustment information and can be deleted or modified at any 
time. Adjustment Layers are a recommended way to make color 
and tone adjustments to your images because they are non-
destructive to your image.  

 
Adjustment Layers are very flexible by allowing the user to easily 
modify, mask, or delete them. Double clicking on the Layer 
Thumbnail will allow you to made changes to the Adjustment 
Layer. 

 

Type Layer 

Type Layers contain only live type. They can be created and 

edited through the use of the Type Tool (  ). 

 

 
Fill Layer 

Fill layers can contain solid colors, gradients, or patterns. 
Create a new Fill Layer by going to Layer in the menu and 
selecting New Fill Layer and selecting either Solid 
Color, Gradient, or Pattern. 

 

Shape Layer 

Shape Layers contain shapes drawn using the Shape Tools. 
To edit a shape layer, select the layer and the Shape Tool for options. 

 

 

Parts 

Parts of a Layer 

Understanding the parts of the layer will help you better understand how layers work and allow you start 

taking advantage of the many layer features. Layers are more than just a singular objects, but they can contain 

many parts and features that help you use layers to your full advantage. Below is a screenshot of a layer and an 

explanation of all the major parts and features. 

 



Layer Thumbnail 
 

This thumbnail shows the contents of the current layer, or, if it is an Adjustment Layer, the Adjustment icon. 

o Tip: Press the CMD (Mac) or CTRL (Windows) key and click on the Layer Thumbnail to create 

a selection of all the contents of that layer. 

Layer Mask 

 

A Layer Mask is like the stencil to a layer. Layer Masks allow certain parts of a particular layer to be shown or 

hidden. Areas of white in the masks are shown while areas of black are hidden.  

 

 Create a new mask by selecting a layer and then clicking the ( ) icon at the bottom of the Layers 

Palette. 

 

 Edit a mask by selecting the Layer Mask Thumbnail within the layer and use the paintbrush to paint 

 

o Tip: Press the CMD (Mac) or CTRL (Windows) key and click on the mask thumbnail to create 

a selection of all the contents of that mask. 

 

 Change mask properties by going to Window and then selecting Properties to reveal 

the Properties Palette. 

 
 

Looking at Layer 
Masks... 

The Layer Mask acts as 
a stencil to layers. Without a 
Layer Mask, the entire image 
would have an orange fill. With 
a Layer Mask, you can indicate 
which parts of the layer should 
be shown (white) and which 
areas should be hidden (black). 

Look at the circular 
Layer Mask in the image to the 
left and compare it to the 
orange circle on the image to 
see how the mask works. 

  

  



Layer Name 

 

This indicates the name of the layer. By default, the name will be determined by the type of layer it is. 

 Rename a layer by double-clicking on the Layer Name, typing in a new name, and hitting the 

ENTER key. 

Visibility Toggle 
 

This is a handy layer feature that allows to to show and hide particular layers without having to delete them. 

Hide or Show a layer by clicking on the eyeball icon to toggle visibility. 

   

Layer and Mask Link 

This link icon appears whenever you add a Layer Mask to a layer. The link helps ensure that any changes to 

the layer is also applied to the layer mask.  

 Link or unlink a Layer Mask by clicking on the link icon ( ) in the layer.  

  

Features 

Layer Features 

Layers are so powerful because of the many features and effects that can be applied to layers. Learning layer 

features will help you create some creative and unique effects for all of your images or composites. We have 

outlined some of the major features of layers in this section. 

 

Opacity and Fill 

 

The Opacity and Fill commands allow you to change the opacity (or transparency) of a layer. Both commands 

work the same except for one difference. In the circles shown below, notice that the Opacity change affects 

both the fill and stroke of the circle and the Fill change affects only the fill and not the stroke of the circle. 

Opacity and Fill changes can drastically change the appearance of a layer and are recommended when trying 

to blend objects or make adjustments more subtle. 

 

 

  

  



Blending Modes 

Blending modes affect the appearance of layers and how they will display. Blending modes are broken down 

into five different groupings that affect the layer differently. The best way to use Blending Modes is to mix and 

match them and experiment with different variations. This Adobe Website provides more detailed information 

and examples of layers with each blending mode applied. 

 
Blending Mode Dropdown 

 

      List of Blending Modes 

 

 

Locking Layers 

Locking layers can be a handy tool when working in Photoshop. There are several ways to lock the layer or 

layer contents. Each layer can be locked by selecting the layer, and then selecting the type of lock. Below are 

the types of locks. 

   Layer Buttons      

There are several buttons that live at the bottom of the layers palette, which we will explore in this 

sections. Many of these buttons perform actions that can be found in other locations within the program, but 

are also in the Layers Palette for convenience and ease. These buttons are outlined below: 

http://help.adobe.com/en_US/photoshop/cs/using/WSfd1234e1c4b69f30ea53e41001031ab64-77eba.html


   Link layers - Select two or more layers and click this button to link them together. Linking 

means that they will all move together. 

   Add a new layer style - This button allows you to add a new layer style without 

going to Layer and selecting Layer Stylein the menu. 

   Add layer mask - Clicking this will add a new layer mask to the selected layer. 

   Create new fill or adjustment layer - This button allows you to add a new layer style without 

using the Adjustments Palette. 

   Create a new group - Click this to create a new group (aka folder). Drag layers into this group 

to organize them. 

   Create a new layer - Clicking this will create a new, empty layer. 

 

   Delete layer - Select a layer or multiple layers and click this button to permanently delete them. 

 

Merging and Flattening Layers 

 

If you ever need to combine several layers or need to flatten the entire image, then use the merge and 

flatten commands. 

 

 Combine or merge several layers by selecting the layers, and then right-clicking on the Layer Name of 

one of the selected layers. Select "Merge Selected" from the menu and all selected layers will be 

combined into one. 

 

 Combine or merge only visible layers () by right clicking on the Layer Name of any visible layer and 

selecting "Merge Visible". 

 

 Flatten an entire image by right-clicking on the Layer Name of any layer and selecting "Flatten Image"  



The Crop Tool 

Straightening and Cropping an Image 

The Crop Tool allows you to straighten and remove unwanted parts of an image and straighten at the same 

time. The crop tool was update in CS6 and has many new features to help you get the best crops. Follow the 

directions below to learn how to use the crop tool and its features.  

Straighten an Image 

1. Select the Crop Tool ( ) from the Tools Palette. A crop box will appear around the edges of your image. 

2. If your image needs straightened, click on the straighten button (  ) in the Options Palette. Click 

and drag across the line or plane you wish to straighten. Once you release the mouse, the image will 

automatically straighten. 

Using the Straighten Tool 

  

 Crop an Image 

1. Select the Crop Tool ( ) from 

the Tools Palette. A crop box will 

appear around the edges of your 

image. 

 2. Grab one of the corner handles on 

the crop frame and drag it to adjust 

the size of the crop box. Adjust the 

crop box using the handles until it is 

at the desired size. 

 

3. To accept the crop, push RETURN 

/ ENTER on your keyboard or click 

on the checkmark (  ) in 

the Options Palette. 

  

  

 

 
How to Crop an Image 



Transforming an Object or Selection 

How to Transform an Object 

 

Many objects, shapes, or images that we create are not always 

the ideal size, rotation, or skew that we want. We can alter or 

transform objects by using the Transform and Free 

Transform Tools. 

 Transform  

The Transform feature allows users to alter their object or 

selection in a variety of ways, such as scale, rotate, distort, or flip 

(mirror). 

 

 To use the Transform feature, select a layer or create a new selections. 

 

Got to Edit in the menu, select Transform, and select the type of transformation you wish to make.  

A bounding box will appear around your selection and allow you to transform it using the handles. If 

you use Rotate 180°, Rotate 90°, Flip Horizontal, or Flip Vertical then your image will automatically be 

transformed. 

 Free Transform 

The Free Transform feature allows you to make several transformations at once, rather than one at a time. 
To use the Free Transform feature, select a layer or create a new selections. 
 
Got to Edit in the menu, select Free Transform. A bounding box will appear around your selection. 
 
You can now transform the selection using the bounding box handles. 
 
 Scale - Grab corner handles and adjust size 
 
 Rotate - Move cursor slightly away from corner handle, moving it away from the selection. The cursor will 
turn into a curved double arrow and allow you to rotate the selection. 
 
Distort - Place your cursor over a handle, hold down the CTRL (Windows) or COMMAND (Mac) key so that 
the cursor becomes white, and grab a handle to distort. 
 
Skew - Place your cursor over a handle, hold down the CTRL (Windows) or COMMAND (Mac) + SHIFT keys 
so that the cursor becomes white, and grab a handle to skew. 
 
Perspective - Place your cursor over a handle, hold down the CTRL (Windows) or COMMAND (Mac) + ALT + 
SHIFT keys so that the cursor becomes white, and grab a handle to change perspective. 
 
Using the transform features to add depth to an image. 
 
 
 
 
 
 
 
 
 



Type Tool 

The Type Tools 

The Type Tools are what you will use when you want to add text to a Photoshop document. The Type 

Tool comes in four different variations and allows users to create both horizontal and vertical type. Note that 

whenever your create type in Photoshop, a new Type Layer will be added to your Layers Palette.  

 Create basic type: 

 

 

1. Select the Horizontal Type Tool ( ) from the Tools Palette. 

 

2. Click and drag to create a text frame. Release your mouse when it is 

the size you desire. 

 

3. Use the Tool Options Palette or Character Palette to select your desired font and font size. (Explained more 

below). 

 

4. Type your text. 

 

5. Select the Move Tool to deactivate the Type Tool move your text box to desired location on document. 

 

Edit type:  

 

1. Select the Type Layer you wish to edit from the Layers Palette. 

 
2. Select the Type Tool ( ) from the Tools Palette. 

 
3. Click on the text in the document using your Type Tool ( ) and highlight it. 

 

4. Type or use the Tool Options Palette or Character Palette to edit text. 

  

Edit type frame:  

 

1. Select the Type Layer you wish to edit from the Layers Palette. 

 
2. Select the Type Tool ( ) from the Tools Palette. 

 

3. Click on the text in the document using your Type Tool ( ) to activate the type frame. 

 

4. Move your cursor to a corner handle of the frame until you see a double-sided arrow and click and drag 

frame to desired size. 

  



Variations of Type Tools 

 

  Horizontal Type Tool - The Horizontal Type Tool is your basic type tool. It allows you to 

create basic text on a horizontal plane. 

  Vertical Type Tool - This tool allows you to create basic text that is written on a vertical plane 

(from top to bottom). 

  Horizontal Type Mask Tool - This tool creates a selection of the text rather than live text. The 

selections can then be used to create masks and clippings. 

  Vertical Type Mask Tool - This tool creates a selection of the text rather than live text. The 

text will be formatted on a vertical plane. The selections can then be used to create masks and clippings. 

   

Type Tool Options 

The Type Tool Options Palette will always appear whenever a Type Tool ( ) is selected. This is 

where you can perform basic formatting to your type, such as changing font, font size, alignment, and color. 

But know that there are more formatting options in the Character and Paragraph Palettes. 

 

 

 

Character and Paragraph Palettes 

To open the Character or Paragraph Palettes, go to Window in the menu 

and select Character or Paragraph. 

  

Character Palette - When editing type in Photoshop, you can use either 

the Tools Options Palette or the Character Palette. One advantage of the 

Character Palette is that is provides you with more options such as being 

able to adjust tracking, leading, and kerning. 

  

Paragraph Palette - The Paragraph Palette is very useful if you are 

working with paragraphs or large blocks of text. The Paragraph Palette 

houses options such as alignment, indentation, and word hyphenation. 

 

 

  

  

  

  

  

  

  

 



Warp Text 

Warp Text Effects 

 

The Warp Text feature in Photoshop allows you to warp your text in many 

different styles from an arch, to a flag, to a fisheye effect. 

 

To open the Warp Text dialog box: 

1. If you have your Type Tool active, click within your text and click on the 

Text Warp button in your Tools Options Palette. 

2. If you do not have the Type Tool active, click on the Type Layer you want 

to warp in your Layers Palette. Go into your menu and select Type > Warp 

Text... (Image right). 

  

 

To Warp your Text: 

 

 

 

1. Select the type of Warp you wish to create by clicking on the 

dropdown menu (highlighted in the image below) and selecting from 

the list. Use the Bend, Horizontal and Vertical Distortion sliders to 

alter the appearance of your warped text. 

   

Correcting Exposure / Tone in an Image 

 

With Photoshop, you change the exposure or tones of an image in a variety of ways, depending on 

what you are trying to do. You can change contrast and brightness of the entire image, or make a selection and 

apply the change to just that small area. These are just a few of the tools you might want to use. 

In the Adjustments Palette, you can choose presets, or click on an icon to make your own choices –

explore! 

·      Brightness/Contrast: applies the same adjustment to every pixel in the selection or image (i.e., if you 

increase the brightness value by 30, 30 is added to the brightness value of every pixel).  

 

·      Levels: allows precise adjustments using three variables (highlights, shadows, and midtowns). Use the 

black (shadow), white (highlight), and gray (midtown) sliders to adjust the black point, white point, and 

overall brightness respectively.  



·      Curves: is similar to levels, but rather than changing sliders on a plane you can add points to a graph. Use 
the eyedropper buttons ( ) to set your black and white points or use the hand icon ( ) to click 

on your image where you would like it be lighter/darker and move your cursor up and down to brighten and 

darken the image.  

 

·      Exposure: use multiple sliders to adjust the exposure, offset, and gamma of an image.  

Correcting Color in an Image 

 

There are many different ways to work with color, including using a variety of tools (some of which are 

discussed below) and applying fill layers (which use a different layer for the fill effect, so it is easier to alter if 

you change your mind). Remember as you’re working with color that Hue is color, saturation is the purity of 

the color, and lightness is how much white or black is in the image.  

In the Adjustments Palette, you can choose presets, or click on an icon to make your own choices – explore! 

 

·      Vibrance: allows you to quickly and easily increase the saturation and vibrance of your image. 

 

·      Hue/Saturation: contains multiple sliders hue, saturation, and lightness. Very quick and easy to use. 

 

·      Color Balance: lets you change the mixture of colors in a color image. Use sliders featuring 

complimentary colors to remove a color cast and to correct the overall color of your image. 

 

·      Selective Color: allows you to select a specific color and change the value and mixture of that color. For 

example, Select Green in the Selective Color panel and you will be given sliders to allow you to change how 

that green appears. You may add more yellow, less black, more magenta, basically whatever color formula 

you'd like. 

 

Working with Selection Tools 

To modify a portion of your image you need to select it first – everything outside the 

selected area is then protected from change. The selected area is then outlined with a dotted line, 

what we refer to as “dancing ants.” The Selection Tools allow you to select portions of the image 

either by location or by pixel color, and thus apply Photoshop’s editing power in specific areas. All 

selection tools can be combined to create exact selections using the Shift key or Alt key 

(Option key on the Mac), to add or subtract respectively (see below for more tips). 

In addition, there is a Refine Edge button in each selection tool Options Palette (see the 

Marquee Tool and Feathering Exercise for a picture of this dialog box). You can adjust the edges of your 

selection – sharpen or blur, smooth the transition, etc. – and then preview what it would look like against 

different backgrounds. 

 



Marquee Tools: The Marquee Tool allows you to make a selection using a rectangle, ellipse, or rows.  Select 

one of the Marquee Tools by clicking and holding on the tool, then sliding over and down to the correct 

selection. 

 

 

Rectangular Marquee Tool Elliptical Marquee Tool 

 

Lasso Tools: The Lasso and Polygon Lasso let you draw both freehand and straight-edged segments 

of a selection border.  The Magnetic Lasso snaps to the edges of a color in the image and is especially useful for 

quickly selecting objects with complex edges set against high-contrast backgrounds.  You can select one of 

the Lasso Tools by clicking and holding on the Lasso Tool, sliding over and selecting the correct option. 

 

Lasso Tool        Polygonal Lasso Tool Magnetic Lasso Tool 

The Quick Selection Tool: The Quick Selection Tool allows you to paint over the area that you 

would like to select by using an adjustable brush tip. As you drag over the area, the selection expands and 

follows defined edges within the image.  

Magic Wand Tool: The Magic Wand selects pixels based on color value, not on their placement in the 

image, and so lets you select an area with similar colors without having to trace its outline. The Magic Wand is 

now found under the Quick Selection Tool. 

 

Selection Tool Tips 

·      To add to a selection, hold down the Shift key and select the additional areas, (you’ll see a plus sign (+) by 

the crosshair). 

·      To subtract from your selection, hold down the Alt key (Windows) or Option key (Mac) and draw the 

additional shape (you’ll see a minus sign (-) by the crosshair). For example, if you have a circle selected and 



drag another smaller circle inside it while pressing the Alt key (Windows) or Option key (Mac), the selected 

shape is then a donut. 

·      To make a circle or a square with the Marquee Tool, hold down the Shift key as you drag. 

·      To drag a marquee from its center, hold down the Alt key (Windows) or Option key (Mac) as you begin 

dragging. 

·      To reposition a marquee, click inside the selection, then drag it to the desired location. 

 

Rulers and Guides 

Rulers and guides are helpful features that aid users in the alignment and placement of objects. Rulers are 

shown at the top and to the left of your Photoshop canvas to help you measure and align. You may also drag 

guides from the rulers to add a grid or set of guides to help you place or align objects. The steps below will 

show you how to set your Rulers and Guide preferences, show rulers, add guides, and hide rulers and guides. 

 

Change Unit / Increment Preferences  

 

In the menu, click on Photoshop and select Preference and General. The Preferences pop-up window 

will appear. 

Select Units & Rulers from the sidebar in the pop-up window and adjust your ruler to inches, pixels, 

millimeters, or other unit of measurement you wish to use. 

 

 

 Click the OK button when you are finished. 

 How to Show Document Rulers 

 To show the Rulers in Photoshop, either go to View in the menu and select Rulers, or press 

CMD+R (Mac) or CTRL+R (Windows) on your keyboard. 

 

To hide Rulers in Photoshop, either go to View in the menu and deselect Rulers, or 

press CMD+R (Mac) or CTRL+R (Windows) on your keyboard. 

  



Creating and Working with Guides      

Create a Guide: Hover your cursor over either the left or top Ruler. Click on the Ruler and drag it as if 

you were trying to move it onto your document.  You will see a thin line appear as you drag from 

the Ruler and this is your Guide. Use the Ruler to help you place the Guide in your desired location.  

 

Move a Guide: Hover your cursor over the Guide and click and drag to move it. 

 

Hide / Show Guides: Go to View in the menu and select Show and select Guides to toggle hide and show 

guides. 

 

Delete Guides: Drag the guides back onto the Ruler, or use the Move Tool to select each guide and press 

the DELETE key. 

 

Change Guide Appearance:  

In the menu, click on Photoshop and select Preference and General. The Preferences pop-up 

window will appear. Select Guides, Grids, and Slices from the sidebar and adjust the colors of your 

guides as desired. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 



Photoshop - Brushes 
The brush tool is a relic that should be cherished and treated like royalty. An expert in the art of Photoshop's 
Brush tool will find it very helpful indeed. 

  
 Photoshop Brush Tool: 

  
 

Photoshop - The Brush Palette 
The small icon located on the tool bar hardly does justice to the tool when compared to the actual brush 
palette. Access the brush palette located toward the top of the program.  Single click the brush tab to activate 
the brush palette. 
The palette is organized into a two column table with preset brushes on the right-hand side and several brush 
stroke options on the left. At the bottom lies a preview that should give you some idea of what your brush 
stroke will do. The brush palette is essentially the ultimate control panel for your brushes. Anything and 
everything can be adjusted with the brush palette. 

 The Brush Palette: 

  
Photoshop - Brush Presets 
Photoshop comes with several brush pre-sets. Later we will discuss how to create your own unique brushes 
but for now scroll through the preset brushes and when you come to the bottom, there's still more hiding from 
your view. To access them, click on the little black arrow located at the top of the palette near the actual 
Brushes tab. A navigation list should pop into view and at the bottom of that list lies about a dozen brush sets. 
 



  Brush Presets 
  

 
Browse through them, familiarize yourself with this palette, and finally pick a brush to paint with and paint 
away on a new layer. 

 Paint Away: 

 
 

Photoshop - Brush Options 
Previously we sort of ignored the left column of the brush palette. Customizing brushes is 
accomplished here. Simply checking one of the boxes here modifies the brush in some 
way. These options are a way to fine tune brushes and can really bring about some 
impressive results. 

 
  Brush Options:  
 
 
 
If the scatter option on your brush isn't already on, click the check 
box to activate this option and then click the text to highlight the 
option and bring the palette into fine-tune mode. 
 
     Scattering Options: 
 

Here we can adjust the amount of scattering that takes place along with the jitter and 
fade options. All really neat features available through the brush palette.  

  

 
 
 



Photoshop - Motion Blur 
Any type of blur in Photoshop softens the pixels, smearing them across the screen. A motion blur has the 
added effect of smearing the pixels in the direction of your choice. A motion blur sort of mimics the effect of 
smearing paint across a canvas sometimes allowing colors to bleed one into another. 
Before and After: 

 
The creation above started out as two separate layers, one with red text and another with black text. The black 
text layer was a few font sizes larger than the red. The whole document is 300 pixels wide and 200 pixels tall. 
 
Highlight Black Layer: 

 
Create a Motion Blur: 
1. With the 'black text' layer selected, Access the Filter menu at the top of Photoshop. 

 
2. Set an angle of motion. 

 
3. Set a distance (in pixels). 

 
 Angle: 20 degrees  Distance: 100 pixels 



PHOTOSHOP BRUSH TOOL 
 

Photoshop – Brush Tool 
The brush tool is a relic that should be cherished and treated like royalty. An expert in the art of 
Photoshop's Brush tool will find it very helpful indeed. 

  
Photoshop - The Brush Palette 
The small icon located on the tool bar hardly does justice 
to the tool when compared to the actual brush palette. 
Access the brush palette located toward the top of the 

program.  Single click the brush tab to activate the brush palette. 
The palette is organized into a two column table with preset brushes 
on the right-hand side and several brush stroke options on the left. 
At the bottom lies a preview that should give you some idea of what 
your brush stroke will do. The brush palette is essentially the 
ultimate control panel for your brushes. Anything and everything 
can be adjusted with the brush palette. 

 
 

Photoshop - Brush Presets 
Photoshop comes with several 
brush pre-sets. Later we will 
discuss how to create your own 
unique brushes but for now scroll through the preset brushes and when 
you come to the bottom, there's still more hiding from your view. To 
access them, click on the little black arrow located at the top of the palette 
near the actual Brushes tab. A navigation list should pop into view and at 
the bottom of that list lies about a dozen brush sets. 
 
Brush Presets: 
 
Browse through them, familiarize yourself with this palette, and finally 
pick a brush to paint with and paint away on a new layer. 
 

 Paint 
 
 

Photoshop - Brush Options 
Previously we sort of ignored the left column of the brush palette. 
Customizing brushes is accomplished here. Simply 
checking one of the boxes here modifies the brush in 

some way. These options are a way to fine tune brushes 
and can really bring about some impressive results. 
 
  Brush Options:  
If the scatter option on your brush isn't already on, click 
the check box to activate this option and then click the text 
to highlight the option and bring the palette into fine-tune 
mode. 
 
     Scattering Options: 
 
 
 
 
 

 



Gradient tool  

The gradient tool can be used to draw linear, radial, angular, reflected or diamond gradients. To use the 

gradient tool go to the Options bar and click on the gradient ramp (see Figure 1) to select a gradient option 

such as Foreground to Background color, or click on the small arrow to the right to open the gradient list (see 

Figure 2). When you drag with the gradient tool inside an image window, a gradient fill is created between 

those two points. If you hold down the Shift key as you do this, you can constrain the gradient angle to a 

horizontal/vertical or 45 degree angle. If you check the Reverse box you can reverse the gradient fill colors 

before you drag. It is probably a good idea to keep the Dither checkbox checked, as this will add subtle noise, 

ensuring there is less risk of any banding appearing in the gradient fill. When the Transparency box is 

checked, if there are transparency masks in a gradient, these will be recognized. 

You will notice in figures 1 & 2 that a number of gradient presets are readily available when you first open the 

gradient list from the Options bar. However, you can also quite easily edit and create your own gradient 

patterns and save these as custom gradient tool presets, which are a combination of a gradient setting and 

gradient type (see the steps below that show you how to create and customize a gradient setting). 

Gradients can also be applied as fill layers in Photoshop. Go to the Layers panel, click on the Adjustment Layer 

button and select Gradient... This will add a gradient that fills the whole layer and has an empty layer mask. 

This feature is like any other type of adjustment layer in that you can edit the Gradient Fill – you can double-

click a Gradient Fill adjustment layer to alter the angle, the gradient setting, gradient type and blend mode at 

any time. 

 

 

Figure 1 To create a new custom gradient, click on the gradient ramp in the gradient options panel. This 

opens the Gradient Editor dialog box shown here. 



 

 

Figure 2 New gradients can also be selected by scrolling down on the gradient ramp in the Options bar and 

these can be edited (see steps below). Once you have selected a gradient setting this can then be applied using 

one of the five gradient tool modes: Linear, Radial, Angle, Reflected or Diamond (see Figure 3). The 

combination of a gradient setting and gradient mode can then be saved as a gradient tool preset by scrolling 

down on the triangle button next to the tool icon shown here and choosing New Gradient. This allows you to 

name the new gradient and add it as a new custom preset to the list. 

Gradient tool modes 

The gradient tool has five operating modes: linear, radial, angle, reflected and diamond. In Figure 3 below you 

can see examples of how each of these modes will affect the way a gradient will fill an image. 

     

Figure 3 The five gradient modes. 

Creating a custom gradient setting 

These following steps show how you can use the Gradient Editor dialog to create a new gradient setting or 

customize an existing one. 


